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1 Introduction

1.1 Overview

The R&S AMREC management allows the configuration and monitoring of
R&S AMREC devices.

The R&S AMREC management consists of the R&S AMREC Manager (=
R&S AMREC client) and the R&S AMREC server.

● The R&S AMREC Manager is the application which interacts with the operator to
perform administrative tasks on the R&S AMREC device.

● The R&S AMREC server is responsible for communicating with the R&S AMREC
device. Also it provides the "ChannelManager" interface to allow other
R&S RAMON applications to perform recording and replay operations.

Figure 1-1: Overview R&S AMREC management components

1.2 Copyright

This document contains proprietary information to Rohde & Schwarz and shall not be
used, disclosed and/or duplicated, printed or copied except in accordance with express
written authorization from Rohde & Schwarz.

1.3 System Requirements

The computer on which this software is to be installed should meet the minimum sys-
tem requirements defined in Table 1-1.
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Table 1-1: Minimal system requirements

 required

CPU Intel® CoreTM i5 CPU

OS Windows 10

RAM 4 GB without database, 16 GB with database

Required Hard Disk space 2 GB without database, 20 GB with database

Graphics card at least OpenGL® 2.1 or later compatible

LAN adapter 1 Gbit/s, RJ-45 connector

NOTES:

Intel® is a trademark of Intel Corporation or its subsidiaries in the U.S. and/or other countries.

OpenGL® and the oval logo are trademarks or registered trademarks of Silicon Graphics, Inc. in the United
States and/or other countries worldwide.

R&S RAMON Workstation/Server
A typical R&S RAMON workstation or server consists of several separate software
products. The system requirements for such combinations typically exceed those sta-
ted here.

1.4 Documentation

This document describes how to use R&S AMREC Manager.

1.4.1 Disclaimer

Every effort has been made by Rohde & Schwarz to make sure that the information
contained within this document is accurate and correct. However, slight differences
may exist between the documentation and particular installations.

The screenshots within this document may show features that are only available with a
certain option.

The contents of screenshots are intended as examples only.

1.4.2 Conventions

The following elements are used in this document.

Tip
Tips give hints such as how to produce more accurate results or optimize calculation
speed.
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Hint
Points out important points to be considered.

Notice
Hints to possibly unexpected program behavior.

Caution
Indicates situations where data loss may occur.

1.4.3 Typographical Conventions

The following text markers are used in this document:

Table 1-2: Typographical conventions

Convention Description

"Graphical user interface elements" All names of graphical user interface elements on
the screen, such as dialog boxes, menus, options,
buttons and softkeys are enclosed by quotation
marks.

KEYS Key names are written in capital letters.

Filenames and commands Filenames, commands and screen output are distin-
guished by their font.

input Input to be entered by the user is displayed in italics.

Links Links that you can click are displayed in blue font.

"References" References to other parts of the document are
enclosed by quotation marks.

 

Documentation
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2 Preparation for Use

2.1 Start-up

2.1.1 Configuring the R&S AMREC Manager

The R&S AMREC Manager connects to the R&S AMREC server using CORBA as
middleware and a proprietary internal R&S RAMON communication layer. In
R&S RAMON systems, the R&S AMREC server and the R&S AMREC Manager are
already preconfigured at delivery to work with your system.

In boxed versions, it is up to the user to configure the R&S AMREC Manager during
installation. Also, it is possible to perform further configurations after installation
through the R&S AMREC Manager "Configuration" window, see Chapter 4.5, "Configu-
ration", on page 43.

2.1.2 Archiving via FTP (File Transfer Protocol)

The R&S AMREC version GX420#4.40_00.01 / GX460#02.00_01.01 and higher offers
the archiving feature via FTP. It can be accessed by a FTP client. The FTP export from
R&S AMREC has been tested with the FTP clients Total Commander 6.53 32 Bit, File-
Zilla 2.2, Internet Explorer 6.0 and FireFox 1.5. The FTP import to R&S AMREC has
been tested with the FTP clients Total Commander 6.53 32 Bit, and FileZilla 2.2.

To access the FTP interface of R&S AMREC, configure your FTP client to anonymous
FTP and point it to the IP address of R&S AMREC. As your client successfully con-
nects to R&S AMREC, it presents you a list of directories, each named with a record
ID. The content of each directory includes the data of each record.
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Figure 2-1: FTP access via file manager

To export a record from R&S AMREC, copy the directory of the record with all its con-
tent from R&S AMREC to your local storage, using your FTP client.

To import a record to R&S AMREC, copy the complete record from your local storage
to R&S AMREC.

Not identifiable records
A complete record is a record which was previously exported from R&S AMREC into a
directory with all its files. Applying manual changes to any name or item within the
directory can result in records not being anymore identifiable by the R&S AMREC
device or the R&S AMREC software.

Notes:

● The number of FTP clients concurrently connected to R&S AMREC is unlimited.
● The number of FTP data transmissions from and to R&S AMREC is limited to one.
● A currently active FTP import or export is temporarily paused if a wideband record-

ing or replay is active.
● A currently active FTP import or export is temporarily slowed down when a narrow-

band recording or replay is active.
● An FTP import or export is rejected if a wideband recording or replay is active.

2.1.3 Starting the R&S AMREC Server

The R&S AMREC server enables the communication between R&S AMREC devices
and applications.

 

Start-up
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It is started as a single service within a closed LAN and serves all R&S AMREC devi-
ces in this LAN. The R&S AMREC server is started automatically during the start-up of
the system.

2.1.4 Starting the R&S AMREC Manager

Start the R&S AMREC Manager client application by selecting in Windows "Start
Menu":

"Start" > "All Programs" > "R&S RAMON" > "AMRECManager" > "AMREC Manager"

Do not confuse the R&S AMREC Manager with the R&S AMREC server.
● R&S AMREC Manager is the client.
● R&S AMREC server is the driver which is automatically started during IT startup.

 

Start-up
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3 User Interface

3.1 Main Window

The R&S AMREC Manager GUI allows you to manage the R&S AMREC servers of the
connected subsystems.

The main window is shown in Figure 3-1.

Figure 3-1: R&S AMREC Manager main window

It contains the following elements:

1. Menu bar, see Chapter 3.2, "Menu bar", on page 14.

2. "Device Status Overview and Selection" dock widget - provides information on the
available servers and devices, see Chapter 3.3, "Device Status Overview and
Selection", on page 16.

3. "Record list" - provides information of the available records for the current device
and a toolbar to manage them. Refer to Chapter 3.4, "Record List Window",
on page 16 for a detailed description.

4. "Files on Amrec" dock widget - allows you to select the current local archive direc-
tory and to perform uploads. Refer to Chapter 3.5, "Files on Archive Dock Widget",
on page 28 for a detailed description.

5. Bottom tabs

 

 

Main Window
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● "FTP Upload and Download" tab - shows the progress of the download/upload
operations, see Chapter 3.6, "FTP Upload and Download Tab", on page 28.

● "Logging" tab - shows the log information, see Chapter 3.7, "Logging Tab",
on page 28 for a detailed description.

● "Info and Maintenance" tab - gives you information on the device and allows
you to perform some actions, see Chapter 3.8, "Info and Maintenance Tab",
on page 29.

6. Status bar - displays a description of the selected command and a button to open
the "Logging" tab.

3.2 Menu bar

3.2.1 File Menu

The option "Exit" terminates the application.

3.2.2 Device Menu

The menu lists the devices currently visible.

When you choose one device from the menu, it is shown in the "Device Status Over-
view and Selection" widget with a green background. The other widgets show the infor-
mation related to the selected device.

3.2.3 Tools Menu

The menu contains the following options:

● "AMREC Device Time..." - allows you to set the device's time, refer to Chap-
ter 4.1.3, "Setting the Device Time", on page 33.

● "Built-in test..." - if it has been closed, reopens the "Info and Maintenance" tab,
where you can start the "BITE" test or read the latest results, as explained in Chap-
ter 4.1.1, "Device Self-Testing", on page 31.

● "Server Configuration..." - allows you to open the "Configuration" dialog, see Chap-
ter 4.5, "Configuration", on page 43.

3.2.4 View Menu

The menu contains the following groups of options:

● A list of the available dock widgets, that allows you to enable/disable them.
● "Close/Open all Dock Widgets" - allow you to enable/disable all the dock widgets.
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● "Reset View to Program Start/Factory Default" - allows you to reset the current
view to a standard one.

● "Update" - updates the current view.

3.2.5 Help Menu

The "Help" menu contains the following options:

● "Contents..."
Opens the manual as a PDF file. The shortcut for this option is F1.

● "Keyboard..."
Opens a dialog box showing all available keyboard shortcuts. The shortcut for this
option is CTRL+F1.

● "Legal Information"
Enables you to open the "Open Source Acknowledgment" document in PDF for-
mat.

● "Info..."
Opens the "Information" dialog box. See Chapter 3.2.5.1, "Information Dialog Box",
on page 15 for a detailed description. The shortcut for this option is CTRL+Q.

3.2.5.1 Information Dialog Box

The "Information" dialog box contains all information about the software, e.g. loaded
modules, configuration and installed options. They are divided into the following tabs:

● "Common"
Displays the name of the application, the version number and copyright informa-
tion.

● "Modules"
Displays a list of all loaded dynamic link library files (Dlls), their version number and
location.

● "Configuration Source"
Displays detailed information related to the configuration:
– "Key" - the current software product. The key determines the entry in the con-

figuration file.
– "Type" - the product type in the client-server infrastructure, either "Client" or

"Server".
– "Target" - the target IP address and port of the configuration source.

● "Options"
Displays an overview of the enabled software options.

● "Configuration"
Displays information on the current software configuration.

● "OpenGL"
Displays the OpenGL capabilities of the installed graphics card.

At the bottom of the "Information" dialog box, two buttons are available:
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● "OK"
Closes the dialog box.

● "Copy to Clipboard"
Copies the content of the dialog box. You can paste it, for example, into a text
document.

3.3 Device Status Overview and Selection

The "Device Status Overview and Selection" dock widget displays a status list, which
contains all attached R&S AMREC servers (marked by the corresponding subsystem
name). For each server, the currently available R&S AMREC devices are also listed.

For each R&S AMREC device, status information like firmware version, IP address,
available/occupied data rate classes and disc space are displayed.

If a device becomes unavailable, or a new configured device becomes available, the
list updates itself dynamically.

3.4 Record List Window

The "Record List" window displays the records contained in the device selected in the
"Device Status Overview and Selection" dock widget and enables you to perform some
actions on them.

 

 

Record List Window
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Figure 3-2: Record list view

The window consists of the following elements:

1. Record list - contains a list with detailed information of the available records. For a
detailed description, see Chapter 3.4.1, "Record List", on page 17.

2. Record actions - toolbar providing buttons to modify the records. The possible
actions depend on the records currently selected, the available user rights, and the
type and firmware version of the software. For a detailed description, see Chap-
ter 3.4.2, "Records Actions", on page 19.

3. Extended filter - This button provides a dialog box which enables you to define cri-
teria to filter the records. For a detailed description, see Chapter 3.4.3, "Records
Filter", on page 26.

4. Name filter - use this filter to filter the list based on the record name.

5. Active device - This label shows the currently active device, including the corre-
sponding sub system.

3.4.1 Record List

The "Record List" is a table providing several columns for detailed records information.
To show or hide some columns, right-click the column header and select the desired
columns from the context menu.

 

Record List Window
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Figure 3-3: Record list - columns show/hide

You can change the column order dragging the columns with the mouse. To sort the
list by a column, click the corresponding column header.

If a filter is activated and the list does not show all records, a filter icon  appears next
to the corresponding column name.

To see all available record information in a compact way, you can over the mouse on
the record name: a tooltip text appears.

Figure 3-4: R&S AMREC record list - record tooltip

For each record, the meta data information provided by the R&S AMREC device is
shown.

NOTE: The displayed "Start Time", "Stop Time" and "Duration" are typically elaborated
from the "Index-Data" (time within the recorded signal) of the record, if available. Oth-
erwise, it corresponds to the time the record was created on the R&S AMREC. In this
case, the device time is colored in blue.

Also, a tooltip is provided to show if the time is derived from the signal time or the
R&S AMREC device time.

NOTE: The ID is generated by the R&S AMREC device upon recording and is guaran-
teed to be unique for the selected R&S AMREC device.

Record List Window
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3.4.2 Records Actions

Use the toolbar or the record list context menu to perform the following actions:

●  "Copy Record"
Enables you to copy parts of the record to a new record on the same device.
The "Copy record" dialog box opens. See Chapter 3.4.2.6, "Copy Record Dialog
Box", on page 23 for further information.

●  "Delete Record"
Deletes the selected records from the R&S AMREC device permanently. Before
the deletion, a confirmation dialog box enables you to cancel the action.
See Chapter 3.4.2.8, "Deleting a Record", on page 25 for further information.

●  "Download Record"
Starts a download of the selected records to the local archive.
See Chapter 3.4.2.2, "Downloading a Record", on page 20 for further information.

●  "Edit Record"
Opens a dialog box where to edit the bookmarks of a record and copying parts of
the record to a new record.
The "Edit record" dialog box opens. See Chapter 3.4.2.7, "Edit Record Dialog Box",
on page 24 for further information.

●  "Reset Record"
Resets the currently selected record which means resetting the record state to
IDLE. This action has only effect if the record is active (not IDLE). Use it only in
error conditions, when it is not possible to stop a started recording or perform a
replay.
See Chapter 3.4.2.1, "Resetting a Record", on page 20 for further information.

●  "Rename Record"
Opens a dialog box where to enter a new name for the selected record. Since the
record is identified by its unique ID, the name does not have to be unique and you
can leave it empty.
See Chapter 3.4.2.4, "Renaming a Record", on page 21 for further information.

●  "Edit Bookmarks"
Opens a dialog box where to edit the bookmarks of a record.
The "Edit Bookmarks" dialog box opens. See Chapter 3.4.2.4, "Renaming a
Record", on page 21 for further information.

●  "Toggle on/off Deletable Flag"
Sets the selected records as "Deletable".
See Chapter 3.4.2.9, "Editing the Deletable Flag", on page 25 for further informa-
tion.

●  "Edit History Comments"
Opens a dialog box to edit the history comments for a record.
The "History" dialog box opens. See Chapter 3.4.2.3, "Editing History Comments",
on page 20 for further information.

●  "Spectrum Overview"
Shows the "Spectrum" overview for the selected record.
See Chapter 4.3, "Working with the Spectrum Overview", on page 35 for further
information.

● "Copy to Clipboard"
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Only available in the context menu. Enables you to copy the selected record infor-
mation to the clipboard.

3.4.2.1 Resetting a Record

If an R&S AMREC record is in a state other than IDLE, it is possible to set the record
idle manually and thus free the resources occupied on the R&S AMREC.

Reset a record
This feature enables you to stop instantly ANY recording or replay currently running on
the R&S AMREC device and performed by another operator.

3.4.2.2 Downloading a Record

If you select "download", an FTP download of the selected record starts. The record is
saved into the local folder currently selected in the "Files on Archive" dock widget,
described in Chapter 3.5, "Files on Archive Dock Widget", on page 28.

To see the progress of the download, open the "FTP Upload and Download" tab. See
Chapter 3, "User Interface", on page 13.

Figure 3-5: Example of an active download of a record

3.4.2.3 Editing History Comments

The "Edit History Comments" dialog box enables you to add or delete the history com-
ments of a record.
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Figure 3-6: History dialog box

It is not possible to change the text of an existing history comment.

● To delete a history comment, click the icon  next to it.
● To add a comment, type the comment on the last row and then

– Click the "Add" icon  to store the history comment through the R&S AMREC,
or

– Select the box "Add new text immediately". The comment is immediately sent
to the device after you have finished editing.

If the comment has been successfully processed by the R&S AMREC, the list
refreshes itself showing the new entry.
The "Date and Time" information are added by the device automatically on receiv-
ing the history comment and cannot be changed.

3.4.2.4 Renaming a Record

If you select "Rename a Record", a dialog box where you can enter a new record
name opens.

Type the name and click "OK" to confirm.

3.4.2.5 Edit Bookmarks Dialog Box

If you select "Edit Bookmarks", this dialog box enables you to edit the bookmarks of a
record.
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Figure 3-7: Edit bookmarks dialog box

On the top, there is a time overview where bookmarks are visualized as small flags.
Below, a table shows the detailed bookmark information.

To edit an existing bookmark, perform one of the following actions:
● Drag&drop the bookmark flag on the time line to move it.
● Double click a bookmark flag in the time line to change the bookmarks text.
● Right-click a bookmark flag in the time line and select "Edit" from the context menu.
● Directly change the time or text within the table.

To add a bookmark, perform one of the following actions:
● Right-click within the time line and select "Add Bookmark" from the context menu.
● Click the icon  within the table to add a bookmark at the current record position

(marked as a yellow triangle within the time line).

To remove a bookmark, perform one of the following actions:
● Right-click a bookmark within the time line and select "Delete".
● Click the  icon next to the entry in the table.

To save your changes, click the "Save" button  on the right part of the time line. To
discard the changes and restore the last saved bookmarks, click the "Reset" button .

If the bookmarks are changed by an external application while the dialog box is
opened, the "Reset" button’s icon changes to .

Record List Window
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Out of range bookmarks

If you start a recording and immediately create a bookmark, it is possible that the book-
mark is created before the recording. The timestamp of the bookmark is therefore not
in the time range of the record. The bookmark does not appear in the spectrum over-
view or in a replay.

The out-of-range bookmarks are identified in the "Edit bookmarks" dialog box by a
warning icon. The "Cut Range" button enables you to delete all bookmarks that are out
of the record's range.

Figure 3-8: Out-of-range bookmark

3.4.2.6 Copy Record Dialog Box

If you select "Copy record", this dialog box enables you to copy a part of a record to a
new record file.

Figure 3-9: Copy record

On the bottom, you can see the selected range within a time line. If the record contains
bookmarks, they are also visible here. The yellow triangle is the current record posi-
tion, move it to define the record range.

If an external application changes the bookmarks, the view updates itself immediately.
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On the top left part, you can see the start and stop time for the selected range. If the
record was created in one day, only the time is available. Otherwise also a date is
shown.

To modify the values, perform the following actions:
● Directly enter the desired time (and date).
● Use the  button to set the value to the current record position (yellow triangle).
● Use the  or  button to set the record start or stop time.
● Use the combo box to select a bookmark (the box is not visible if the record does

not contain any bookmarks).

If an invalid value is selected, the dialog box automatically tries to change it. For exam-
ple, if a start time is entered, which is beyond the current stop time, the stop time is
automatically set to the record stop time.

On the top right part, the total record range and the duration of the currently selected
range are shown. You can enter a new record name and copy the range with the given
name to a new record by clicking the "Save" button .

3.4.2.7 Edit Record Dialog Box

If you select "Edit record", this dialog box opens. It combines the "Edit Bookmarks" dia-
log box (Figure 3-7) and the "Copy Record" dialog box (Figure 3-9).

For a detailed description, see the corresponding chapters.
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Figure 3-10: Edit record dialog box

3.4.2.8 Deleting a Record

To delete a record, right-click it and choose "Delete record" from the context menu,
then confirm.

If the "Deletable" flag of a record is set to "false", you cannot delete it. Therefore, if you
select and delete multiple records, only the records which are deletable are deleted.
For more information, see Chapter 3.4.2.9, "Editing the Deletable Flag", on page 25.

3.4.2.9 Editing the Deletable Flag

The "Deletable" flag of a record determines whether it can be deleted or not.

Furthermore, records which are not "Deletable" are also not involved in the "Auto Dele-
tion" process (see Chapter 4.5.4, "Auto Deletion", on page 46).

To change the "Deletable" flag of the selected records, use the corresponding icon in
the toolbar or the context menu. The action is only available if all selected records have
the same "Deletable" state.
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3.4.3 Records Filter

3.4.3.1 Name Filtering

You can use the text filter to show only the records which match the text entered.

Figure 3-11: Record list - name filter

To reset the filter, clear the text or click the "Reset" button .

You can select the following filter type from the dropdown list:
● "Fixed string" - All records having the text within the name are shown.
● "Wildcard" - wildcard characters ("*","?",",") can be used within the filter text (see

below).
● "Regular expression" - The filter string is treated as a regular expression (see

below).

A checkbox enables you to set the filter as "Case sensitive".

Wildcard characters

The wildcard characters are the same that are provided by most command shells such
as cmd.exe (Windows) or a bash shell (Unix).

● "?" - matches any single character.
● "*" - matches zero or more occurrences of any character.

Example: 
Given the record names (1) "my 1 record" , (2) "my first record", (3) "their first record",
the filter “my * record” matches the first and second entry. The filter “my ? Record” only
matches the first entry.

Regular expressions

Use the regular expressions to perform advanced text filtering. For example, the regu-
lar expression “^$” shows all records having an empty record name.

3.4.3.2 Extended Filtering

The "Extended Filter Settings" dialog box is available to use extended filters related to
the other columns of the record list.
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Figure 3-12: Extended filter settings

Depending on the type of information provided, appropriate conditions for each column
are available. E.g. for the record "size" you can define a lower or an upper limit (or
both). For the "Data Rate", you can select only a subset of possible values to show.

The filters are applied to the record list when you edit them.

Use the button  "Reset All" to reset all filters.

Use the button  "Save" to save the selected filters.

Use the button "Restore" to load the filters from a file.

Record List Window



User InterfaceR&S®AMREC Manager

28User Manual 3029.3320.02 ─ 47

3.5 Files on Archive Dock Widget

The "Files on Archive" dock widget allows you to choose the local archive folder and
displays its content.

Downloading a record

When you download a record, as described in Chapter 3.4.2.8, "Deleting a Record",
on page 25, it is saved into the folder currently selected in the "Files on Archive" dock
widget.

If you want to download a record to a different folder, first set the folder in the "Files on
Archive" dock widget.

Uploading a record

If you right-click on a record displayed in the "Files on Archive" dock widget, the con-
text menu offers you the following possibilities:

● "Upload the Record" uploads the record to the device currently selected in the
"Device Status Overview and Selection" dock widget.
The progress of the upload is shown in the "FTP Upload and Download" tab.

● "Delete the Record" deletes the record from the local directory selected.

3.6 FTP Upload and Download Tab

Shows the progress of the following operations:

● Download of a record to the local archive, see Chapter 3.4.2.2, "Downloading a
Record", on page 20.

● Upload of a record from the local archive to the selected device, see Chapter 3.5,
"Files on Archive Dock Widget", on page 28.

3.7 Logging Tab

The "Logging" tab displays all messages that appear while the R&S AMREC Manager
is open.

Figure 3-13: The logging tab

Depending on the content and severity of the message, they are classified as:
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● "Message"
● "Warning"
● "Error" or
● "Exception"

If you right-click, the context menu offers you the following actions:

● "Save as" saves the content to a file.
● "Send to Printer" prints the content.
● "Clear" clears the content of the window.

3.8 Info and Maintenance Tab

The "Info and Maintenance" tab displays information about the current device and
allows you to perform some actions.

Figure 3-14: Info and maintenance tab

The left part of the tab displays the following information of the device currently
selected in the "Device Status Overview and Selection" dock widget:

● Device name.
● Sub system name.
● Date and time of the latest "BITE" test.
● Result of the latest "BITE" test.

The central part of the tab contains the results of the latest "BITE" test.

The right part contains a toolbar whit the following commands:

● "Start the BITE test", refer to Chapter 4.1.1, "Device Self-Testing", on page 31 for
further information.

● "Reboot the device", refer to Chapter 4.1.2, "Device Reboot and Shutdown",
on page 33 for further information.

● "Shutdown the device", refer to Chapter 4.1.2, "Device Reboot and Shutdown",
on page 33 for further information.
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4 Operation
R&S AMREC Manager provides a view of the sub systems, their R&S AMREC devi-
ces, and their data. It also enables administrative tasks to be performed.

The following chapters describe hot to use R&S AMREC Manager.

● Devices Management............................................................................................. 31
● Records Management.............................................................................................34
● Working with the Spectrum Overview..................................................................... 35
● Handing over IQ Recordings...................................................................................42
● Configuration...........................................................................................................43

4.1 Devices Management

To see the information related to a currently visible device, select it from the "Device"
menu or select it in the "Device Status Overview and Selection" dock widget: the
device is set as currently active and is marked with a green background color.

Figure 4-1: Device menu

The information is displayed in the adjacent dock widgets of the main window, as
shown in Figure 3-1.

4.1.1 Device Self-Testing

All R&S AMREC devices provide a Built-in-Test (BITE).

As a R&S RAMON default, the BITE test is automatically executed at start-up on every
device. Therefore, when you select a device in the "Device Status Overview and Selec-
tion" dock widget, you see the test results in the "Info and Maintenance" tab.

To start manually the test, perform these steps:

1. Select the desired device from the "Status" widget or form the "Device" menu.
The device has now a green background.

2. Choose "View" > "Info and Maintenance" to open the corresponding tab.
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Figure 4-2: View menu

The device name is shown at the left pane of the "Info and Maintenance" tab.

3. Start the "BITE" test by pressing the corresponding "Start Bite" button, as shown in
Figure 4-3.

Figure 4-3: Info and maintenance window

The "BITE" test starts.
The test results are displayed in the main area of the "Info and Maintenance" tab.
The R&S AMREC device sends messages related to all its internal components
and their state. Each step can take some time.
When the test is complete, the button "Start Bite" becomes active again.

You can save the "BITE" log to disk or print the log file.

Once the "BITE" test is running, it is not possible to stop it. During the test recording or
replaying is not possible.

The "BITE" test can only be performed if you have the "Carry out Build-In-Test" right in
R&S User Manager.

Devices Management
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4.1.2 Device Reboot and Shutdown

The "Info and Maintenance" tab described in Chapter 4.1.1, "Device Self-Testing",
on page 31 offers also the possibility to perform a reboot or shutdown.

Click the desired button:

● "Reboot the selected AMREC device"

Figure 4-4: Info and maintenance tab - reboot button

● "Shutdown the selected AMREC device"

Figure 4-5: Info and maintenance tab - shutdown button

The reboot or shutdown can only be performed if you have the "Manage AMREC
resources" right in R&S User Manager.

4.1.3 Setting the Device Time

R&S AMREC devices usually get their time from NTP (network time protocol) or their
internal real-time clock. It is not recommended to set the time from the R&S AMREC
Manager.

To control whether the R&S AMREC is synchronized via NTP, choose "Tools" >
"AMREC Device Time". The "Set AMREC Device Time" dialog opens.
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Figure 4-6: Set device time dialog

If the device is synchronized with NTP, the "OK" button is disabled. If the device is not
synchronized with NTP, you can change the time and confirm by pressing "OK".

You have the following options:

● "Synchronized by NTP" indicates whether the NTP synchronization is enabled.
You can enable/disable the NTP synchronization via the R&S AMREC web inter-
face, which can be accessed by entering the R&S AMREC IP address in any web
browser. The R&S AMREC IP address is visible in the "Status Overview" on the left
pane in the R&S AMREC Manager window. After you have enabled the NTP syn-
chronization, you need to reboot the R&S AMREC device. After rebooting, it can
take 20 minutes before R&S AMREC trusts and uses the NTP server.

● "Use local PC-Time" couples the edit controls to the local PC-Time.

4.2 Records Management

Records are stored on R&S AMREC devices or possibly on other devices where they
have been archived via FTP.

All records are shown in the "Record list" of R&S AMREC Manager main window. See
Chapter 3.4, "Record List Window", on page 16 for a detailed description.

You can filter the records, see Chapter 3.4.3, "Records Filter", on page 26.

You can perform different actions on the records, see Chapter 3.4.2, "Records
Actions", on page 19.
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4.3 Working with the Spectrum Overview

4.3.1 General

The "Spectrum" overview shows a spectrogram that enables you to search for signals
of interest on a visual basis in a record. You can display the spectrogram of the whole
record or zoom to specific time ranges to get a higher resolution.

Only records in "IDLE" state and with "CONTENT" or "EB200" data format provide
spectrum data and can therefore be used in the "Spectrum" overview.

The "Spectrum" overview enables you to perform the following actions:

● Set the time range and the resolution:
– Set the start and stop time, and
– Set the FFT length and the FFT windowing mode used to calculate the spec-

trum data.

The data is directly requested from the storage device with the given parameter
and a resolution which depends on the current size of the spectrogram window.
Therefore, each time you change one of the parameters, including the zoom opera-
tions and the window size editing, the spectrum data is reloaded from the storage
device.
If there are long time ranges, the loading process can take some time. A status
message is shown and all input elements are disabled to prevent any changes
while the data is being loaded.

● See and edit bookmarks and save them permanently to a record file.
● Save a copy of a time range to a record file on the storage device.

4.3.2 Main Window

The main window of the "Spectrum" overview is shown in Figure 4-7.
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Figure 4-7: Spectrum overview window

It contains the following elements:

1. The window title, showing the name or the ID of the record.

2. The "Time Line", providing information on the time range of the record. It also ena-
bles you to see and edit the bookmarks. Refer to Chapter 4.3.3, "Time Line/Book-
mark Editor", on page 36 for a detailed description.

3. The main toolbar, providing all functionality. Refer to Chapter 4.3.4, "Spectrogram
Toolbar", on page 38 for a detailed description.

4. The "Spectrogram", that contains the "level" data curve and the "waterfall" related
to the current time marker position on the given frequency range. Refer to Chap-
ter 4.3.5, "Spectrogram", on page 39 for a detailed description.

4.3.3 Time Line/Bookmark Editor

Figure 4-8: Time line

The "Time line" provides a time graph showing the current range and all bookmarks
within that time. It is possible to edit the bookmarks or moving the time marker with the
mouse.
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Bookmarks consist of a time position and a text related to it. If the mouse pointer
moves over a bookmark, its text is shown. To change the time position, click a book-
mark. Move it along the time axis and release the mouse button. Double-click to edit
the text.

If you right-click a bookmark, the context menu opens. Select "Edit" to edit the book-
mark text (same as double-clicking it), or "Delete" to delete it.

If you right-click on a free position and select "Add Bookmark" from the context menu,
a new bookmark is added at the given position.

For managing the bookmarks through the spectrogram, see Chapter 4.3.6.3, "Manag-
ing Bookmarks in the Waterfall", on page 41.

The following commands are available.

1. "Scale mode" - if checked, the "Time line" is scaled to the currently zoomed time
range. Otherwise, the "Time line" always shows the whole record time range and
the positions of the time markers (2, 4 and 5) are restricted to the currently zoomed
range.

2. "Start time position" - time marker used to select a start time position. It is directly
connected to the start time marker in the spectrogram.

3. "Current time position" - time marker used to select the current time position. It is
directly connected to the time marker of the spectrogram.

4. "Bookmarks" - bookmarks are displayed as blue flags. Move the mouse pointer
over a bookmark to see its name.

5. "Stop time position" - time marker used to select a stop time position. It is directly
connected to the stop time marker in the spectrogram.

6. "Save bookmarks" - saves the bookmarks shown permanently to the record file. If
you change the bookmarks and close the dialog box without using this button, all
changes are lost.

7. "Reload bookmarks" - reloads the bookmarks from the record file, discarding all
local changes. The button provides two modes indicted by two different icons:

● "Reset bookmarks" - the bookmarks have been changed in the "Spectrum"
overview. The button resets the bookmarks to the original state.

● "Refresh bookmarks" - another application made changes to the book-
marks of the record. The button refreshes the bookmarks to this state.

If the "Reload Bookmarks" button indicates that bookmark changes have been done by
an external application and you select "Save Bookmarks", the changes made by the
external application are overwritten.

Working with the Spectrum Overview
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4.3.4 Spectrogram Toolbar

Figure 4-9: Spectrogram - Toolbar

The toolbar provides all basic information and the available actions.

1. "Show duration" - shows the duration in the label next to it.

2. "Time marker label" - provides information on the currently selected time range
between the "Start time position" and the "Stop time position". If "1" is not selected,
it shows the start/stop time directly. If "1" is selected, it shows the duration of the
time range.

3. "Zoom In/Out" - zooms in/out to the currently selected time range given by the
"Start time position" and the "Stop time position". For further details, see Chap-
ter 4.3.6.1, "Zooming / Selecting a Time Range", on page 40.

4. "Reset zoom" - resets/clears the zoom, showing the complete record file. For fur-
ther details, see Chapter 4.3.6.1, "Zooming / Selecting a Time Range",
on page 40.

5. "Copy range" - enables you to copy a part of the record to a new record file. For
further details, see Chapter 4.3.6.2, "Copying a Time Range", on page 41.

6. "Replay button" - starts a replay of the currently zoomed time range for that
record on another R&S RAMON application. For further details, see Chap-
ter 4.3.6.4, "Performing a Replay", on page 42.

7. "FFT Length" - enables you to select the FFT length.

8. "FFT Window mode" - enables you to select the FFT windowing mode.

9. "Refresh" - refreshes/reloads the current spectrum data from the device.

10. "Show Bookmarks" - displays the lines corresponding to the bookmarks in the
waterfall.

11. "Settings" - opens the "Configuration" dialog box, that enables you to set several
parameters related to the spectrogram.
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4.3.5 Spectrogram

Figure 4-10: Spectrogram window

The spectrogram consists of:

1. "Data" curve - shows the level data curve for the current time position.

2. "Frequency" axis - provides the frequency axis to the data curve and the water-
fall.

3. "Waterfall" - waterfall of the currently zoomed range. Each line represents a time
and each pixel on that line is mapped to a color according to the level value on that
frequency. The mapping between color and level value is visible on the left part of
the data curve.

4. "Stop" time position - time marker used to select a stop time position. It is directly
connected to the time marker of the "Time line".

5. "Current" time position - time marker used to select the current time position. It is
directly connected to the time marker of the "Time line".

6. "Frequency" marker - frequency marker. At start it is in the middle frequency. You
can move it using the mouse.

7. "Bookmark" time position - bookmark marker. It is directly connected to the time
marker of the "Time line".

8. "Start" time position - time marker used to select a start time position. It is directly
connected to the time marker of the "Time line".
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The "Waterfall" window times are sorted with newest times on the top and oldest on
the bottom. Therefore the top position marker corresponds to the "Stop Time Position"
and the bottom marker to the "Start" time position.

If you right-click the "Data Curve" or in the "Waterfall" window, the context menu
appears. The menu offers some basic operations of the toolbar and the additional
items:

● "Select range…" - enables you to select the time range to display.
● "Add bookmark" - enables you to add a bookmark to the record.

4.3.6 Using the Spectrogram

4.3.6.1 Zooming / Selecting a Time Range

It is possible to zoom in  to a "Start" - "Stop Time Position" time range. The range has
to be smaller than the currently zoomed range and at least 1 second long. If the "Time
Line" is scaled to the current zoomed time range, it only shows bookmarks within that
range. To select the "Start" and "Stop Time Position", drag them with the mouse either
in the "Time Line" or in the "Waterfall" window.

The "Time Marker" label in the "Spectrogram" toolbar is dynamically refreshed to show
always the corresponding times or the duration.

To zoom out, zoom to the previous time range  or reset the zoom  to see the whole
record time.

You can also enter directly the time range to zoom, by choosing "Select range…" from
the context menu of the "Spectrogram".

The "Select Time Range" dialog box opens and displays the current values of the
"Start" and "Stop Time" positions.

The day, month and year values are hidden if the record was started and stopped on
the same day.

If there are bookmarks available in the record, you can select a time for a given book-
mark by using the corresponding combo box.

Use the reset buttons  to set respectively the time to the record's "Start" or "Stop"
time.

Confirm the time range and start the zoom operation by clicking the "OK" button. The
internal zoom history is cleared: after a time range has been selected, you can zoom
out to the whole record time range only once.
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4.3.6.2 Copying a Time Range

You can copy a selected time range to a new record using the corresponding toolbar
action or the context menu option. A dialog box appears, providing the same function-
ality as the "Select Time Range" dialog box described in Chapter 4.3.6.1, "Zooming /
Selecting a Time Range", on page 40.

You can enter a name for the copy, or choose the _copy name created by default.

You can select the desired "Start Time" and "Stop Time". They are initially set to the
current values and can be modified as described in Chapter 4.3.6.1, "Zooming / Select-
ing a Time Range", on page 40.

Choose a suitable name to be able to find the record on the device. The record gets a
unique record ID internally by the storage device, which is not displayed.

4.3.6.3 Managing Bookmarks in the Waterfall

Adding bookmarks

Perform one of the following actions:

● While pressing STRG, click an empty waterfall line. The bookmark is created with a
default name.

● Right-click an empty waterfall line and select "Add Bookmark" from the context
menu. An inline edit opens for you to type the bookmark name. Confirm by press-
ing ENTER.

Editing bookmarks

Perform one of the following actions:

● Drag and drop a bookmark line.
● Right-click a bookmark line and select "Move Bookmark" from the context menu.

Move the mouse to the destination and click to confirm the new position.

Renaming bookmarks

Perform one of the following actions:

● Double-click the bookmark.
An inline edit opens where to edit the bookmark name. Confirm by pressing
ENTER.

● Right-click the bookmark and select "Rename Bookmark".
An inline edit opens where to edit the bookmark name. Confirm by pressing
ENTER.

Deleting bookmarks

To delete a bookmark, right-click it and select "Remove Bookmark".
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Undoing actions on bookmarks

To undo the last change made to a bookmark in the waterfall, right-click the bookmark
and choose "Undo Position" or "Undo Name" from the context menu.

4.3.6.4 Performing a Replay

The "Replay" button enables you to hand over the current record to another
R&S RAMON application for replay purposes. The drop-down list shows you the avail-
able targets of the handover.

See Chapter 4.4, "Handing over IQ Recordings", on page 42 for further information.

Figure 4-11: Record handover

The replay is only started in the external application. Other operations like pausing or
stopping have to be done directly through the replay application, if available. If the
replay application does not pop up automatically, you need to start it manually.

4.4 Handing over IQ Recordings

You can transmit recordings during their creation from one R&S RA120 application
(sender) to another (recipient).

Sender

The sender can be one of the following:

● R&S CA120 - You can send a recording from:
– The "Replay Control" toolbar.
– The context menu of the "Production Results" window.

● R&S AMREC Manager
You can send a recording from the "Spectrum Overview".
See Chapter 4.3.6.4, "Performing a Replay", on page 42.

● R&S CA120 Manager
You can send a recording from the "Spectrum Overview".

● R&S Presentation Suite Session Data Manager
You can send a recording from the "Content" window.
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Recipient

The recipient can be one of the following:

● R&S CA120 Manager.
When a recording is received, a dialog appears, allowing you to choose how to
proceed.
The following options are available:
– "Show" - shows the received recording in the list of the "Storage Device Admin-

istration" and selects it.
– "SCP Replay" - starts the configuration of an SCP replay production using the

received recording as source.
– "MCP Replay" - starts the configuration of an MCP replay production using the

received recording as source.
– "Ignore" - ignores the received recording.

● A running R&S CA120 replay production.
When a recording is received, the software stops the current replay and sets the
received recording as the new replay source. If a replay range is received (e.g. via
the zoomed range of the "Spectrum Overview") a running MCP replay production is
needed, that is then set accordingly.

4.5 Configuration

4.5.1 R&S AMREC Server Configuration Dialog

Choose "Tools" > "Server Configuration..." to open the "Configuration" dialog. The dia-
log shows the R&S AMREC server configuration for all available and connected sub
systems.

Figure 4-12: AMREC server configuration dialog

The left part shows the configuration of each available sub system. See Chapter 4.5.2,
"Sub System Configuration", on page 44 for a detailed description.
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The right part contains the following tabs:

● "Available Devices" - see Chapter 4.5.3, "Available Devices Tab", on page 45 for
a detailed description.

● "Auto Deletion".

4.5.2 Sub System Configuration

The left pane of the "Configuration" dialog shows the configuration of each available
sub system.

The following parameters are displayed:
● Name: The configured name of the R&S AMREC. This name has to be unique

within the sub system.
The name is normally not editable for existing entries. It can only be changed if a
new device entry has been added (see below).

● IP address: The configured IP address to use to communicate with the
R&S AMREC.
If the R&S AMREC corresponds to a device with several IP addresses, double-click
the IP address to select one of them.

● Port: The port number to use for communication.
Double-click to edit the parameter.

● Interface: The interface (CORBA or XML) to use for communication.
Double-click to edit the parameter.

● Auto deletion: If set to off, the "Auto Deletion" process is never performed on this
device. For further information, refer to Chapter 4.5.4, "Auto Deletion",
on page 46.

On changing the "Interface", the "Port" is automatically set to the default port (CORBA
= 8000, XML = 24394), if it has not been changed previously. If you change the port,
make sure that the corresponding R&S AMREC is using this non-default port. Other-
wise no connection can be established.

The "Interface" field suggests which interface to use. If the R&S AMREC does not sup-
port this interface (e.g. because the corresponding device type or firmware version
does not support it), the R&S AMREC server chooses a default one.

For R&S CA120 PU-S devices, the port number is not shown and cannot be modified
because the PU-S uses a different port number each time it gets started/restarted.

4.5.2.1 Devices Management

To remove a device, right-click on it and select "Remove" from the context menu (or
press CTRL + X).

To add a new device, right-click within the configuration dialog and select "New" (or
press CTRL + N). You can also drag an entry from the "Available Devices" tab and
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drop it to the desired sub system. It is possible to drag a configuration item from one
sub system to another.

The name of the last added device is editable, as indicated by an icon  next to the
name. If the R&S AMREC has not been added from the available device list, its IP
address is also directly editable, allowing you to configure devices which are currently
not online. To confirm the name and IP address, right-click on the device and select
"Apply".

A warning icon  next to the name of a device is shown whenever configuration errors
are detected. For example, an IP is configured several times, or the configured IP is
not within the list of available devices. If you move the mouse over the item, a tooltip
text shows a detailed warning description. Check whether it is due to a real error or to
the desired configuration.

4.5.3 Available Devices Tab

The "Available Devices" tab on the right pane shows the currently available
R&S AMREC devices. Each device sends a broadcast UDP message periodically. This
message and its content are used to fill the list.

The "Available Devices" list provides the following information:
● Type: The R&S AMREC device type. An icon  is shown if this device is used

within the current configuration. If the device is configured several times the icon
changes  to indicate a configuration error. Moving the mouse over the "Type" field
shows a tooltip which provides information about the configured sub systems.

● IP address: The configured IP address. If the R&S AMREC has several IP
addresses “…” is added to the visible address. On moving the mouse over the
address field, all addresses are shown as a tooltip.

● Firmware: The firmware string that has been received within the broadcast mes-
sage.

● Last broadcast: The time of the last received broadcast from that device. This
time is refreshed permanently as the devices send their broadcasts periodically.
The icon shows the status of the last broadcast:
–  - The device is up and sending broadcast.
–  - No broadcast has been received within the last minute.
–  - No broadcast has been received with the last 15 minutes.

The mapping between broadcasts and entries within the available device list is done by
the configured IP addresses. Therefore if an R&S AMREC device gets reconfigured
with a new IP address, its old entry stays in the list but never gets refreshed. The warn-
ing or error icon is shown in the "Last Broadcast" column. To remove these old entries,
right-click within the list and select "Reset" (CTRL+F5). The current content is cleared
and the list contains only newly received device information.
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4.5.3.1 Changing Source

It is possible to change the source of the available device information. Right-click the
list and select "Source" from the context menu.

Figure 4-13: Source option

The following options are available:

● "Local" is the default option. A local UDP listener is used. "Local" only shows
R&S AMREC broadcasting, since the dialog has been opened.

● The "sub systems" are listed. If you choose one sub system, a UDP listener at the
corresponding R&S AMREC server of that sub system is used. Helpful when the
network configuration prevents that R&S AMREC UDP broadcasts are received at
the GUI system. A sub system shows all devices which have sent at least one
broadcast since the corresponding R&S AMREC server has been started.

R&S CA120 PU-S configuration
To see the R&S CA120 PU-S devices which can be added to the configuration, select
the sub system where the R&S AMREC server and the R&S CA120 installations are.

4.5.4 Auto Deletion

The "Auto Deletion" is a process performed by the R&S AMREC server. The server
checks all available R&S AMREC regularly and, if necessary, deletes obsolete/old
records automatically. Only records which are deletable (seeChapter 3.4.2.9, "Editing
the Deletable Flag", on page 25) are deleted.

To enable/disable "Auto Deletion" for a R&S AMREC device, use the corresponding
parameter in the sub system configuration (see Chapter 4.5.2, "Sub System Configura-
tion", on page 44).

To configure the "Auto Deletion" for each available sub system/R&S AMREC server,
use the "Amrec Server Configuration" dialog: select the desired sub system/server and

 

 

Configuration



OperationR&S®AMREC Manager

47User Manual 3029.3320.02 ─ 47

open the "Auto Deletion" tab in the right. See Chapter 4.5.1, "R&S AMREC Server
Configuration Dialog", on page 43 for further information.

4.5.4.1 Auto Deletion Configuration

The "Auto Deletion" tab allows you to configure the "Auto Deletion" process.

Figure 4-14: Configuration - auto deletion tab

Use the "Reset" button next to the sub system name to reset the configuration parame-
ter to the start-up values, in case you want to discard its current changes. The "Activa-
ted" checkbox determines if "Auto Deletion" is enabled or disabled and the "Interval"
determines in which time intervals the "Auto Deletion" is processed.

If "Auto Deletion" is enabled, "Next Execution" shows the remaining time . Also, a but-
ton lets you execute "Auto Deletion" immediately and reset the counter afterwards. The
button is disabled while "Auto Deletion" is executed or if it is not enabled.
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If "Auto Deletion" is executed within the "Configuration" dialog, the currently changed
parameters are not taken into account and "Auto Deletion" is performed with the start-
up parameter. To apply the configuration changes, restart the corresponding
R&S AMREC server.

Records older than the given "Expiration Time" are deleted. To disable this process,
set the parameter to "Never".

To determine how old a record is, the R&S AMREC server always uses the
R&S AMREC system time and the "Creation Time" of the record. The "Creation Time"
can differ from the "Signal Time" shown in the record list.

To distinguish between different data formats, the "Data Format Settings" can be
enabled and a special "Expiration Time" can be set to a list of data formats. All records
with the given data format use this special time instead of the default one.

Example: 
The default "Expiration Time" is set to 14 days and the "Expiration Time" for data for-
mats "SPECTRUM" and "DECODED TEXT" is set to the special value "Never". The
result is a deletion of all records which are older than 14 days, except the given data
formats, which are never deleted automatically.

Archived records and auto deletion
If records are uploaded from an archive to an R&S AMREC, the "Creation Time" of
these records is not updated. Therefore, it is possible that they are removed immedi-
ately by next "Auto Deletion" process, if they are considered to be too old. To prevent
this process, set the "Deletable" flag of these records to "false".

Additional to the "Expiration Time ", it is possible to define certain limits which result in
an automatic deletion of records. To enable these limits, check the corresponding
checkbox:
● "Record Count": If the total number of records on an R&S AMREC exceeds the

"Upper Limit", the oldest records are deleted until the "Lower Limit" is reached.
● "Disc Space Usage": If the disc space usage exceeds the "Upper Limit", the oldest

records are deleted until the "Lower Limit" is reached.

Configuration
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Combining auto deletion parameter
If several "Auto Deletion" parameters are combined, the "Expiration Time " always has
the highest priority. If one (or both) of the "Upper Limit" is exceeded, first the expired
records are deleted. Only if the limit is still exceeded, which means that the "Lower
Limit" is not reached yet, additional records are deleted, starting from the oldest ones.

Applying changes

If some changes are made, the "OK" button is enabled. Click it to apply the new config-
uration to the corresponding sub systems.

Figure 4-15: Applying changes to the configuration

The corresponding R&S AMREC servers restart. A warning message indicates the sub
systems involved and asks you to either apply, close the dialog without changes, or
cancel the operation and keep the dialog open.

Figure 4-16: Configuration locked

A sub system can be write-protected, as indicated by a special lock icon next to its
name. In this case, the configuration of that sub system cannot be changed. The write-
protection is due to the configuration of the R&S AMREC server on that sub system, or
to the missing corresponding user right.

Configuration



OperationR&S®AMREC Manager

50User Manual 3029.3320.02 ─ 47

Configuration



TroubleshootingR&S®AMREC Manager

51User Manual 3029.3320.02 ─ 47

5 Troubleshooting
This chapter contains the most common problems and their solutions.

Always check the "Logging" tab for error messages.

● The device does not appear
– After booting an R&S AMREC device, it can take up to 5 minutes for it to

appear in the list of devices.
– Make sure that the device is connected to the network.
– Check the configuration of the device. Check that the IP address indicated in

the configuration and type in ping <address> to be sure that the IP address
is correct.

● I cannot delete a record
If the context menu for deleting a record is grayed, ask an administrator for the cor-
responding user right. Deleting a record requires the "Supervisor" right.
Refer to the R&S User Manager manual for further information.

● The menu commands are grayed
The commands of the "Options" menu are enabled according to the current state of
the R&S AMREC Manager and the current users rights. Perform the following
actions:
– Check in the "Logging" tab if there is the "User logged on" message entry. If

this line is missing, make sure that the R&S AMREC Manager is running and
that you are logged in.

– Check the "Device" menu. If the menu is empty, make sure that the
R&S AMREC Manager is running and that R&S AMREC devices are connec-
ted and started.

● A tab or a dock widget is not displayed
Probably the tab or dock widget has been closed or disabled. Use the "View" menu
to enable it again.
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Glossary
A

ACD: Auto calculate diagrams

AFC: Automatic frequency control

AGC: Automatic gain control

AMMOS: Automatic modular monitoring of signals

AMREC: R&S AMMOS IT recording. An external device providing recording and replay
of digital IF.

AOI: Area of interest. General term for the geographic, physical and organizational
area about which information is to be obtained using technology and other means.
NOTE: It normally covers several areas of responsibility.

AOR: Area of responsibility. Description for a fixed/assigned geographic physical and
organizational area about which information is to be obtained by using technology and
other means.

AP: Automatic processing

ASK: Amplitude shift keying. Form of modulation that represents digital data as varia-
tions in the amplitude of a carrier wave.

B
BDH: Burst duration histogram

BITE: Built-in test equipment

C
CF: Center frequency

Communications signal database: The database, where data from the R&S RAMON
systems are stored.

D
DCP: Digital channel processor

DDC IPC: A DDC-IPC uses the digital wideband IF provided by a wideband tuner as
input signal and contains a digital down converter (DDC) as digital tuner.
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DF: Direction finding. Part of radiolocating using the reception of radio waves to deter-
mine the direction in which a station or an object is located.

DLL: Dynamic-link library

DSC: Detect, search, classify

DTMF: Dual tone multiple frequency

F
FFE: Feed forward equalizer

FFM: Fixed frequency mode. Operating mode of a receiver for which the selected cen-
ter frequency remains unchanged.

FFP: Fixed frequency processing

FFT: Fast Fourier transform

FSK: Frequency shift keying. Modulation method for digital signals.

G
GUI: Graphical user interface

H
HF: High frequency. Frequency range according to standard: 3 MHz to 30 MHz; in
R&S AMMOS IT up to 30 MHz.

HMI: Human machine interface

I
IBA: Intra-Burst analyzer

IF: Intermediate frequency. Mixed frequency. Connection or frequency position within a
receiver which is mostly higher than AF. The IF is not yet demodulated.

IPC: Interception processing channel. Interception processing channel. Predefined and
uniquely configured interception and processing sequence in R&S AMMOS IT that can
be parameterized (e.g. "Morse", 1 kHz BB, etc.).

IPC-MC: Multichannel IPC. A Multichannel IPC consists of a wideband receiver and
several independent digital signal processing units, each controlled by an individual
control state machine.
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IPC-SC: Single channel IPC. A single channel IPC consists of one receiver and a sin-
gle signal processing unit, both controlled by one control state machine.

IQ: Format of digital data streams represented as values obtained through complex
sampling

J
JDH: Job detailed HMI

M
MC: Multichannel

MCFSK: Multichannel frequency shift keying

MCP: Multichannel processing

MCPSK: Multichannel phase shift keying

MGC: Manual gain control.

MSK: Minimum-shift keying. Type of continuous-phase frequency-shift keying. MSK
encodes each bit as a half sinusoid.

N
NOI: Not of interest. Emission to be ignored.

P
PSK: Phase shift keying. Modulation method for digital signals.

PU: Processing unit.

Q
QAM: Quadrature modulation. Modulation type for which the phase and amplitude are
modulated. A rectangle is obtained in the phase constellation diagram.

QPSK: Quadrature phase shift keying. PSK with four possible states.

R
RDTH: Relative distribution in timeslot histogram

RF: Radio frequency

RTV: Real-Time visualization, e.g. spectrum, decoded text, etc.
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S
SC: Single channel

SCP: Single channel processing

SNR: Signal-to-noise ratio

ST: Short time

SU: Storage unit.

T
TOH: Timeslot occupancy histogram

U
UDP: User datagram protocol.

UHF: Ultra high frequency. Frequency range 300 MHz to 3000 MHz (3 GHz). For
R&S AMMOS IT, up to 3.6 GHz.

V
VHF: Very high frequency. Frequency range 30 MHz to 300 MHz.

W
WBCL: Wideband control

WKF: Well known frequency

X
XG interface: R&S propriety 10 Gbyte interface.
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